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File Menu

The File menu includes commands that enable you to open,import and export files, delete a
database, and to setup database parameters.

For more information, select the File menu command name.




File New Command

Use this feature to create a new PMS database. When you select "New", a screen
marked "Open File Screen" will appear. You may select an existing directory by double-clicking
on one of the drives in the menu, and selecting the desired directory. Then select the "OK"
button. The new database file will be created.

You also have the choice of making a new directory in this window. Select the "Make a
New Directory" box. Next type the directory name in "New Directory " box at the top of the
screen. Next select the desired drive from the list shown. You may scroll through your entire
system; both drives and directories. If you double-click on a drive designation, PMS will return
all the directories in that drive. In this way, you may be sure you do not duplicate a directory
that has been created. When the desired new directory name shows properly following
"Directory:" select the "OK" button, and the new directory will be created.

At any time during this process, you may elect to cancel the process by selecting the
"Cancel" button. Do not attempt to create a new PMS file in a directory that already has a PMS
database file in it; otherwise, PMS would assume that the data in that directory belongs to the
new file. An error message will return if you attempt to do so. Each PMS database must
reside in a separate directory. (There is no problem with using the same drive.)

PMS will give you access to this newly created database file at any time you desire; along
with all the databases you have created. The new file will be a duplicate of the file you are in
when you create the new one. The only difference will be that there is no information in the new
file. If you desire to change the labels for checkboxes, etc., simply run the setup procedures for
the new file. Until you give a name to the new database file, PMS will call it "No System Name".



File Open Command

When you select this feature, a screen will appear that will give you a list of all the
existing databases you have created to-date. To select a different database to work on, select
the name of the desired database and select the "OK" button. The database you are working on
will be closed, with all the changes you have made saved; and the new database will be opened
and appear on your screen.



File Import Command

Choose this feature to import database information from another source. In order to
import data, the fields must exactly match the fields of PMS. This is useful for transferring bulk
names and addresses into PMS. For more information about Import, see the "Technical
Reference" section.



File Export Command

Choose this feature to export database information from PMS's files to other files or for
use with word processing merge features. For more information on Export, see the "Technical
Reference" section.



File Delete Command

Delete will remove an entire database from your computer. You will be presented with a list of
databases existing on the computer and asked to select the database to delete. Selecting "OK"
will remove all PMS related database files from the selected directory.



File Setup Command

Select this menu item to set up a new database file created with the "New" feature. Here
you will name the new file, choose the People and Event category names, etc..



Setup - System Parameters

System Title: Type in the name for this database. This is the name that will appear in
the top bar of your main PMS screen. Itis also the name of the database which will appear for
selection when you are using the "Open" function.

Comm Port: Type in the Comm Port that will be used for the AutoDial feature. This will
tell PMS where to find the phone line. The form for your input should be: COM1

Administrator: Type in the name of the person in charge of Administration of the
database.

Home Event: Type in the title you would like automatically placed in the Event Title Box
each time you call someone's home (example; "Phone Log - Called placed to home"). This title
is optional for setup procedures, and even if you specify a title, you will be able to change it once
the program is running.

Business Event: Type in the title you would like automatically placed in the Event

Title Box each time you call someone's business (example; "Phone Log - Called placed to
Business"). This title is optional for setup procedures, and even if you specify a title, you will be
able to change it once the program is running.

Fax Event: Type in the title you would like automatically placed in the Event Title Box
each time you call someone's fax number (example; "Phone Log - Called placed to fax
number"). This title is optional for setup procedures, and even if you specify a title, you will be
able to change it once the program is running.



Setup - Event Checkboxes

Use this feature during setup, to type in names of the different categories you anticipate
will adequately describe the normal events for your database (examples might be "Received
Letter"; "Sent Memo"; "Phone Call Received"; "Phone Contact Made"; etc. ) Using this process,
you are "customizing" PMS to your own needs. Give consideration to these category names, as
you will be able to search by these categories, and reports available will  also use the category
names.



Setup - People Checkboxes

Use this feature during setup, to type in names of the different categories you anticipate
will adequately describe the normal people classifications for people in your database (examples
might be "Volunteer", "Contributor", "Relative", "Client", etc. ) Using this process, you are
"customizing" PMS to your own needs. Give consideration to these category names, as you will
be able to search by these categories, and reports available will also use the category names.



File Printer Setup Command

Choose "Printer Setup", and the screen will show you the printer(s) available for use
through WINDOWS Tv. If more printers appear than you plan to use PMS with, you do not have
to remove them. Highlight the printer you plan to use, and select to "OK" button. There are
some options on the "Setup" button, but your printer should be already configured through
WINDOWS TM. If you have any problems with printer interface, please see the "Technical
Reference " section.



File Exit Command

Choose this feature to "Exit" from your PMS database program. The "Close" feature in
the WINDOWS v system menu in the upper left corner of the main PMS screen provides
the same function.



Edit Menu

The Edit menu includes commands that enable you to move text to and from the clipboard,
to delete text, and to undo a previous editing operation. These operations are only
effective for the comments field for an individual. PMS uses a program internal clipboard for
copying address records and event records. You may, however, use the shift-insert and
shift-delete key combinations to transfer text via the Windows clipboard anywhere in the
program.

For more information, select the Edit menu command name.

Clear Deletes text without moving it to the clipboard.
Copy Copies text to the clipboard.

Cut Deletes text and moves it to the clipboard.

Paste Moves text from the clipboard to the edit window.
Undo Cancels a previous operation.



Maintenance Menu

The Maintenance menu includes commands that enable you to Add, Update or Delete People
and Events

For more information, select the Maintenance menu command name.

People Maintenance Menu Maintains People Records.
Event Maintenance Menu  Maintains Event Records.




Event Maintenance Menu

This section is used to add, delete, or update information for events in your database. It
is necessary to first select the person with whom the event is associated. If you are using a
mouse, it will be easier to use the "Add", "Update", and "Delete" buttons that appear
immediately to the right of the block that displays the current list of events. This location is in
the lower right hand corner of the PMS screen.

Add Event Adds Event Records.
Update Event Updates Event Records.
Delete Event Deletes Event Records.



Add Event

This function is used to add events for any person to your database. First select the
person to whose file you wish to add the event. To start this function, select the "Add" button
that appears in the lower right corner of the main PMS screen. or select "Maintenance", then
"Event Maintenance", then "Add Event" from the menu bar. When you select "Add Event", a
screen will appear showing the selected person's name at the top. The information entered
here will be the basis of PMS's ability to respond to your later inquiries, so take the time to enter
as complete information as you can.

You will notice a "date and time" box at the top of the screen. This should be today's
date, and the current time. Each time you add an event, PMS will record both the time and
date, so you may refer to it at any later time. If you wish to record the event as occurring at
some other date or time, you may change either the date, the time, or both. To change the date,
select the "month" box, and use the scrolling device to increase or decrease the month #.

Next, select the "day" box, and again, scroll up or down till you see the desired date. Continue
from box to box for both the date, and time , if desired. The same effect can be achieved by
tabbing from box to box, and entering the desired date or time from your computer keyboard.
Changing from "AM" to "PM" is accomplished by either of these methods.

The long, rectangular box that runs across your screen, immediately below the date &
time box, is used to record the "Event Title". When you are on the main PMS screen, this is the
information you will see when the person is selected on the record list. Also, the date and time
that the event occurred, or was recorded, will be shown. Briefly describe the event, in terms that
will be clear to you when only the title appears .

Beneath the "Event Title" box, is another blank box. In this "Event Comments" section,
you may enter any message, note, or information you desire. The message can be up to
approximately 1000 characters. Each person in your database may have multiple events; the
titles, dates, and times, will be shown on PMS's main screen, in reverse chronological order
(most recent events first), when the person's name is selected or highlighted in the people list.
Both "Event Titles" and "Event Comments" are available to be printed out on various reports.



Update Event

This function will allow you to change the information about any event in your database.
Only the information associated with the Event functions is available for change; information
associated with people may be changed using the "People Update" function. To start the update
function, select the "Update" button that appears to the right of the "Event Titles" box, in the
lower right hand corner of the main PMS screen, or select "Maintenance", then "Event
Maintenance", then "Update Event " from the menu bar. The use of the "Update" function
requires that you select the name, then the event, that is going to be updated; if you do not
select an event, PMS will remind you by an error message on your screen. If the wrong record
presents itself for updating, this is because you had an event selected, or highlighted, on the
main screen (select "Cancel", and try again).

When updating, you will use a similar screen to the "Add Event" screen. In fact, it's the
same, except it will show the name of the person selected at the top of the screen. All the
people information you entered, or even information you did not have at the time of original
entry, can be added or changed at this time. If you make any changes, including the Event
Category selections, the database will be changed accordingly. If you select the "Cancel" button,
no changes will be made; the record remains as it was in the database. When you select the
"OK" button, the changes are made to the database, and PMS returns you to its main screen.

A shortcut to "Update" an event when using a mouse is to double-click on the
event. The "Update" screen will appear.

You may also use the "Update" function to check on any information in the "event" portion
of your database. Select "Cancel" after you are finished reviewing information, and no changes
will be effected in your database.



Delete Event

This function is used to permanently remove events from your database. Be cautious
with the use of the delete function, as the information deleted may not be retrievable. To
delete an event from your database, first select the name from the record list on your main PMS
screen. Then, select the Event you wish to delete. Then select the "Delete" button in the lower
right of your main PMS screen, or select "Maintenance", then "Event Maintenance", then "
Delete Event". The event selected will be removed completely from the database. . If you
make an attempt to use the "delete" function without first selecting the event to delete, you will
get an error notice reminding you to do so. However, if you have highlighted an event prior to
selecting the "delete" function, that event will be deleted.



People Maintenance Menu

The Maintenance menu includes commands that enable you to Add, Update or Delete People
and Events

This section is used to add, delete, or update information for people in your database. If
you are using a mouse, it will be easier to use the "Add", "Update", and "Delete" buttons
that appear immediately above the block that displays the current list of people. This
location is directly below the menu bar, and in the upper left hand corner of the PMS screen.

For more information, select the Maintenance menu command name.
Add Person Adds People Records.

Update Person Maintains People Records.
Delete Person Deletes People Records.




AddPerson

Selecting ADD PERSON from this menu will present you with a dialog box to enter
information for a new individual. This is the same as selecting the ADD button just under
the menu bar..

This funtion is used to add each person to your database. When you select "Add Person",
the "Add Person" screen will appear. The information entered here will be the basis of
PMS's ability to respond to your later inquiries, so take the time to enter as complete
information as you can. Notice that you have the ability to enter a prefix, a middle initial,
and a suffix, or title. Make your decision early as to how complete a record your use
requires. There is a "Company Name" box for you to use. If the new person to your
database is associated with a company or organization, be sure to enter this information;
one of the functions of PMS will allow you to display and search your database from this
criteria. After you have added the new person's address, you have the option to enter a
2nd address as well. To do this, select the "Add 2nd Address" button, and fill in the 2nd
address when the new screen appears. It is possible to toggle between the primary and
secondary addresses at will, using the two buttons provided for second addresses.
Company addresses may be primary or secondary; it all depends how you plan to use them.
PMS suggests you make the address to which you would send information by mail the
primary one. You can always tell at a glance which address is being displayed; again by the
selections allowed on the two address buttons. Although the Fax Phone is a handy part of
the PMS database, the autodial feature of this version does not have a valid use forit. You
may find that some persons in your database have a third phone number you would like to
have on record; record it in place of the Fax #. The final entry for adding a member to
your database is the checkbox section. During your setup procedure, you decided what
"people categories"” you will be using. Select the categories for the person being added,
by clicking the appropriate box with your mouse cursor. An "X" will apear in each category
box selected. You may choose one or more; either as positive or negative, depending on
the information you have about your person as you enter the new name. If you do not have
the need for a full 20 categories in your database, you may use empty category boxes later
to select "special" or "temporary" subset lists (See Helpful Hints Section). Finally, you have
the option of selecting "Cancel" or "OK", using the buttons in the lower left corner of the
"Add Person " screen. If you select "Cancel", the information you have entered will not be
changed or added to your database. When you select "OK", the information showing on
your "Add Person" screen will become part of your database. Therefore, it is important NOT
to use this function for updating information; entering partial information could replace
more complete information in your database (use the "Update" function to change or add
information for anyone already entered in your database).



Update Person

This function will allow you to change the information about any person in your database.
Only the information associated with the People functions is available for change; information
associated with events may be changed using the "Event Update" function. To start the update
function, select the "Update" button that appears directly above the people list on your main
PMS screen, or select "Maintenance", then "People Maintenance", then "Update Person" from the
menu bar. The use of the "Update" function requires that you select the name that is going to be
updated; if you do not select a name, PMS will remind you by an error message on your screen.
If the wrong record presents itself for updating, this is because you had a hame selected, or
highlighted, on the people list (select "Cancel", and try again).

When updating, you will use a similar screen to the "Add Person" screen. In fact, it's the
same, except it will show the name of the person selected at the top of the screen. All the
people information you entered, or even information you did not have at the time of original
entry, can be added or changed at this time. If you make any changes, including the People
Category selections, the database will be changed accordingly. If you select the "Cancel" button,
no changes will be made; the record remains as it was in the database. When you select the
"OK" button, the changes are made to the database, and PMS returns you to its main screen.

A shortcut to "Update" a person when using a mouse is to double-click on the person's
name. The "Update" screen will appear.

You may also use the "Update" function to check on any information in the "people"
portion of your database. Select "Cancel" after you are finished reviewing information, and no
changes will be effected in your database.



Delete Person

This function is used to permanently remove persons from your database. Be cautious
with the use of the delete function, as the information deleted may not be retrievable. To delete
a person from your database, first select the name from the record list on your main PMS screen.
Then select the "Delete" button above the people list, or select "Maintenance", then "People
Maintenance", then " Delete Person". The person selected will be removed completely from the
database, and the number of records will be reduced by one; reflecting the change made. If you
make an attempt to use the "delete" function without first selecting the person to delete, you will
get an error notice reminding you to do so. However, if you have highlighted one of the names
on your record list, that person will be considered selected, and will be deleted.



Subset List Menu

When you create a "Subset List", you are limiting certain information which would
normally appear on your screen, or appear in reports produced. The advantages of such
limitation make PMS a "friendly" information manager, as it eliminates the need to view many
file folders of information, making scrolling through names and events much easier and quicker.
It also gives you the opportunity to produce reports for specified dates or date periods, and for
limited persons or events.

A unique feature of PMS helps you keep track of the criteria used for determining each
subset list. When you enter into a subset list ("working database"), a pull down menu
("Options") appears on the top right of your main PMS screen; just under the menu bar. It
shows the basic subset list sub-menu item; listing the criteria used for specific selection on the
pull down portion of the menu.

When you create a Subset List, only the persons who conform to your specially selected
criteria appear on the people list on the screen. The number of records that are available
through your limiting criteria will be specificied, in the "# of # Records Selected" box in the
center of PMS's main screen, just below the menu bar. ( When you are not working with a
Subset List, the message "Full DATABASE" will appear immediately below this box. ) Only people
with classifications or events that conform to the limited criteria are displayed. You are creating
a special "working database" , which will be limited until you tell PMS to restore the Full
Database. Information in your database is not limited during this process; only the amount of
information available for and viewing and printing is affected.

When you are using a "working database", created by using the Subset List function, the
message "Subset" will appear below the "# of Records Selected" box, and this box will tell you
how many persons in your full database conform to your limiting criteria. When there are more
people or events than will fit in the "people list" box, or the "event list" box, a scroll bar will
appear at the right hand side of the appropriate box. This will enable you to access the
additional names or events.

When you select a subset based on Event criteria, PMS will find the people that have
those events; it will not find the events. You may emphasize the events by which you selected
the subset list by choosing "Show Only Selected Events" under the "Options" menu.

Set Date Limits
People - Any Check
People - All Checks
Events - Any Check
Events - All Checks
Restore Full List




Subset - Set Date Limits

This option will allow you to limit the amount of data you have in your "working
database", by restricting the available Event information to a specific date, or a specific date
range. Rather than view and search your entire database, with Events over periods of months or
years, you can "tell" PMS you only wish to access the information flow for the last two months; or
the last two weeks; or just today's Events. Even if a person in your database has no events in
the specified time period, his name will continue to be part of your "working database".

However, for those persons who have older Events, the non-specified events need not appear on
the screen. (See "Options" menu).

To set date limits, select "Set Date Limits" from the menu bar. A screen will pop up that
says "Set Event Search Dates-Currently Off(Set)". If you have been working with a specified date
limitation, the message will read "Currently Set"; if not, it will read "Currently Off'. The date bar
is operated in the same manner as previously described. Tab from field to field, and either type
the information in, or scroll to the desired dates. First specify the "Start Date", then specify the
"End Date". If you make the start date and end date the same, you will limit yourself to one
day's activities. This is especially useful for monitoring or reporting of daily activities. A
message "Date Set" will appear on the top of your screen to remind you that you are working
with the limited database showing.

Clear

You need not change the date range to end the limits to your "working database". By
selecting the "Clear" button, the search range dates will be toggled to read "Currently Off".
Regardless of the date range shown in the "Set Event Search Dates" box, PMS will ignore them.
You may return to this box at any time and reactivate the same search range by selecting the
"Set" button.

Set

Selecting the "Set" button informs PMS that you are about to set a search date range.
You may now tab from field to field, entering the specified date range through your keyboard, or
select with your mouse and scroll to the desired dates. You may be more comfortable with
changing the date(s), and then choosing "Set".

Cancel

Selecting the "Cancel" button will return you to the PMS main screen, and make no
changes to the search date range. If the selection is "Currently Off", it will remain off. It the
selection is "Currently On", it will remain on. This is useful if you would like to check whether
your range is "On" or "Off" without making any changes.

OK

When you have specified your new date range, select the "OK" button. This will tell PMS
you have completed your changes, and to accept them. Your selection will be "On" or "Off",
whichever the box shows before selecting "OK". You will be returned to the PMS main screen.



Subset - People - Any Check

When you select this function, a screen will appear entitled "Subset List for People - Match
any Check". You will see the People Categories you have chosen for your database, but now
there will be a "NO" box for each category. You may check one or more categories, and PMS will
limit your subset list to those that match any check. You may select a "NO" in one or more
categories, and PMS will include persons who are "not" in that category also. If you select three
categories, a person who meets only one of the search criteria WILL be included in your subset
list.

Checkboxes

Tab from field to field, entering your selection by using your spacebar, or select any box
with your mouse, and toggle the field with your left mouse button. Successfully selected fields
will show an "X" in the field. To unselect a field, select again.

OK

When you are sure you have selected all the desired criteria, select the "OK" button. You
will be returned to the PMS main screen.

Cancel

Regardless of any changes made (or not made), selecting the "Cancel" button will return
you to the PMS main screen without recording any changes in the subset list.



Subset - People - All Checks

When you select this function, a screen will appear entitled "Subset List for People - Match
All Checks". You will see the People Categories you have chosen for your database, but now
there will be a "NO" box for each category. You may check one or more categories, and PMS will
limit your subset list to those that match ALL checks. You may select a "NO" in one or more
categories, and PMS will include persons who are "not" in that category also. If you select three
categories, a person who meets only one of the search criteria WILL NOT be included in your
subset list. Only persons who match each and every criteria specified, either positive or
negative, will be included in your subset list. If your search range appears too narrow, try again
after removing some of the search criteria.

Checkboxes

Tab from field to field, entering your selection by using your spacebar, or select any box
with your mouse, and toggle the field with your left mouse button. Successfully selected fields
will show an "X" in the field. To unselect a field, select again.

OK

When you are sure you have selected all the desired criteria, select the "OK" button. You
will be returned to the PMS main screen.

Cancel

Regardless of any changes made (or not made), selecting the "Cancel" button will return
you to the PMS main screen without recording any changes in the subset list.



Subset - Events - Any Check

When you select this function, a screen will appear entitled "Subset List for Events - Match
any Check". You will see the Event Categories you have chosen for your database, but now there
will be a "NO" box for each category. You may check one or more categories, and PMS will limit
your subset list to those that match any check. You may select a "NO" in one or more
categories, and PMS will include persons who are "not" in that category also. If you select three
categories, a person with events that meets only one of the search criteria WILL be included in
your subset list.

Checkboxes

Tab from field to field, entering your selection by using your spacebar, or select any box
with your mouse, and toggle the field with your left mouse button. Successfully selected fields
will show an "X" in the field. To unselect a field, select again.

oK
When you are sure you have selected all the desired criteria, select the "OK" button. You
will be returned to the PMS main screen.
Cancel

Regardless of any changes made (or not made), selecting the "Cancel" button will return
you to the PMS main screen without recording any changes in the subset list.



Subset - Events - All Checks

When you select this function, a screen will appear entitled "Subset List for Events - Match
All Checks". You will see the Event Categories you have chosen for your database, but now there
will be a "NO" box for each category. You may check one or more categories, and PMS will limit
your subset list to those persons that have events that match ALL checks. You may select a
"NO" in one or more categories, and PMS will include persons who are "not" in that category
also. If you select three categories, a person who meets only one of the search criteria WILL NOT
be included in your subset list. Only persons who match each and every criteria specified, either
positive or negative, will be included in your subset list. If your search range appears too
narrow, try again after removing some of the search criteria.

Checkboxes

Tab from field to field, entering your selection by using your spacebar, or select any box
with your mouse, and toggle the field with your left mouse button. Successfully selected fields
will show an "X" in the field. To unselect a field, select again.

oK
When you are sure you have selected all the desired criteria, select the "OK" button. You
will be returned to the PMS main screen.
Cancel

Regardless of any changes made (or not made), selecting the "Cancel" button will return
you to the PMS main screen without recording any changes in the subset list.



Subset - Restore Full List

When you select "Restore Full List", you will stay in the PMS main screen, and all the
records will be returned to the available database; the screen will again display the maximum
data. The "# of # Records Selected" box will show all records selected, and the remark "Full
DATABASE" will appear immediately under that box.



AutoDial Menu

In order to enjoy the maximum benefit from this function, your system should be
connected to a modem, and a phone set should be readily available by your computer terminal.
Using this feature, you may dial a person's home, business, or fax phone; entering a record of the
time and date of the event (call) if you desire to do so. Should you choose to "create an event"
by the call, you may accept the event title specified in your setup, or re-title the event, and even
record your comments (through your keyboard) up to 1000 characters. For similar calls to many
persons in your database, you may use the "Edit" function to copy, and then paste the same
information to each person called.

When you select one of the "AutoDial" features, a pop up screen will appear that says
"Dialing", and PMS will dial the number selected. Itis not necessary for you to enter any phone
numbers; PMS will dial the number according to your selection. When the connection to the
called party is made, select the "OK" button, and pick up your phone. If the call does not go
through, or the line is busy, select the "OK" button to terminate the call.

Dial Home

Dial Business

Dial Fax

Dial Home - Create Event
Dial Business - Create Event
Dial Fax - Create Event




Dial Home

Select this feature, and PMS will automatically dial the phone number you entered as
"Home" phone number when you added this person to your database.



Dial Business

Select this feature, and PMS will automatically dial the phone number you entered as
"Business" phone number when you added this person to your database.



Dial Fax

Select this feature, and PMS will automatically dial the phone number you entered as
"Fax" phone number when you added this person to your database.



Dial Home - Create Event

Select this feature to have PMS dial the home number of the desired party, and record
your pre-selected title for the event on an "Add Message" screen.

The screen will appear showing the selected person's name at the top. The information
entered here will be the basis of PMS's ability to respond to your later inquiries, so take the time
to enter as complete information as you can.

You will notice a "date and time" box at the top of the screen. This should be today's
date, and the current time. PMS will record both the time and date, so you may refer to it at
any later time. If you wish to record the event as occurring at some other date or time, you may
change either the date, the time, or both. To change the date, select the "month" box, and use
the scrolling device to increase or decrease the month #. Next, select the "day" box, and
again, scroll up or down till you see the desired date. Continue from box to box for both the
date, and time if desired. The same effect can be achieved by tabbing from box to box, and
entering the desired date or time from your computer keyboard. Changing from "AM" to "PM" is
accomplished by either of these methods.

The long, rectangular box that runs across your screen, immediately below the date &
time box, is used by PMS to display (and record) the message title you selected during setup
procedures. When you are on the main PMS screen, this is the information you will see when
the person is selected on the people list. Also, the date and time that the event occurred, or was
recorded, will be shown. You may modify the event title if you desire to do so; put your cursor
in the title box and edit with your keyboard.

Beneath the "Event Title" box, is a blank box. In this "Event Comments" section, you may
enter any message, note, or information you desire. The message can be up to approximately
1000 characters. Each person in your database may have multiple events; the titles, dates, and
times, will be shown on PMS's main screen, in reverse chronological order (most recent events
first), when the person's name is selected or highlighted in the people list. Both "Event Titles"
and "Event Comments" are available to be printed out on various reports.

The last section of the "Create An Event" function is for you to select one or more Event
Categories; bearing names that you selected during the setup function. You will be able to
search by these categories of events at any time after they are selected. Tab from box to box,
recording your selection(s) by hitting your spacebar, or select any box with your mouse cursor
and click on it. An "X" will appear in each selected category. To "unselect" any category, select
it again; the toggle action will remove the "X", and the selection.

Finally, you have the option of selecting "Cancel" or "OK", using the buttons in the upper
right corner of the "Create An Event" screen. If you select "Cancel", the information you have
entered will not be changed or added to your database. When you select "OK", the information
showing on your "Add Event" screen will become part of your database. (Use the "Update"
function to change or add event information for anyone already entered in your database).



Dial Business - Create Event

Select this feature to have PMS dial the business number of the desired party, and record
your pre-selected title for the event on an "Add Message" screen.

The screen will appear showing the selected person's name at the top. The information
entered here will be the basis of PMS's ability to respond to your later inquiries, so take the time
to enter as complete information as you can.

You will notice a "date and time" box at the top of the screen. This should be today's
date, and the current time. PMS will record both the time and date, so you may refer to it at
any later time. If you wish to record the event as occurring at some other date or time, you may
change either the date, the time, or both. To change the date, select the "month" box, and use
the scrolling device to increase or decrease the month #. Next, select the "day" box, and
again, scroll up or down till you see the desired date. Continue from box to box for both the
date, and time if desired. The same effect can be achieved by tabbing from box to box, and
entering the desired date or time from your computer keyboard. Changing from "AM" to "PM" is
accomplished by either of these methods.

The long, rectangular box that runs across your screen, immediately below the date &
time box, is used by PMS to display (and record) the message title you selected during setup
procedures. When you are on the main PMS screen, this is the information you will see when
the person is selected on the people list. Also, the date and time that the event occurred, or was
recorded, will be shown. You may modify the event title if you desire to do so; put your cursor
in the title box and edit with your keyboard.

Beneath the "Event Title" box, is a blank box. In this "Event Comments" section, you may
enter any message, note, or information you desire. The message can be up to approximately
1000 characters. Each person in your database may have multiple events; the titles, dates, and
times, will be shown on PMS's main screen, in reverse chronological order (most recent events
first), when the person's name is selected or highlighted in the people list. Both "Event Titles"
and "Event Comments" are available to be printed out on various reports.

The last section of the "Create An Event" function is for you to select one or more Event
Categories; bearing names that you selected during the setup function. You will be able to
search by these categories of events at any time after they are selected. Tab from box to box,
recording your selection(s) by hitting your spacebar, or select any box with your mouse cursor
and click on it. An "X" will appear in each selected category. To "unselect" any category, select
it again; the toggle action will remove the "X", and the selection.

Finally, you have the option of selecting "Cancel" or "OK", using the buttons in the upper
right corner of the "Create An Event" screen. If you select "Cancel", the information you have
entered will not be changed or added to your database. When you select "OK", the information
showing on your "Add Event" screen will become part of your database. (Use the "Update"
function to change or add event information for anyone already entered in your database).



Dial Fax - Create Event

Select this feature to have PMS dial the fax number of the desired party, and record your
pre-selected title for the event on an "Add Message" screen.

The screen will appear showing the selected person's name at the top. The information
entered here will be the basis of PMS's ability to respond to your later inquiries, so take the time
to enter as complete information as you can.

You will notice a "date and time" box at the top of the screen. This should be today's
date, and the current time. PMS will record both the time and date, so you may refer to it at
any later time. If you wish to record the event as occurring at some other date or time, you may
change either the date, the time, or both. To change the date, select the "month" box, and use
the scrolling device to increase or decrease the month #. Next, select the "day" box, and
again, scroll up or down till you see the desired date. Continue from box to box for both the
date, and time if desired. The same effect can be achieved by tabbing from box to box, and
entering the desired date or time from your computer keyboard. Changing from "AM" to "PM" is
accomplished by either of these methods.

The long, rectangular box that runs across your screen, immediately below the date &
time box, is used by PMS to display (and record) the message title you selected during setup
procedures. When you are on the main PMS screen, this is the information you will see when
the person is selected on the people list. Also, the date and time that the event occurred, or was
recorded, will be shown. You may modify the event title if you desire to do so; put your cursor
in the title box and edit with your keyboard.

Beneath the "Event Title" box, is a blank box. In this "Event Comments" section, you may
enter any message, note, or information you desire. The message can be up to approximately
1000 characters. Each person in your database may have multiple events; the titles, dates, and
times, will be shown on PMS's main screen, in reverse chronological order (most recent events
first), when the person's name is selected or highlighted in the people list. Both "Event Titles"
and "Event Comments" are available to be printed out on various reports.

The last section of the "Create An Event" function is for you to select one or more Event
Categories; bearing names that you selected during the setup function. You will be able to
search by these categories of events at any time after they are selected. Tab from box to box,
recording your selection(s) by hitting your spacebar, or select any box with your mouse cursor
and click on it. An "X" will appear in each selected category. To "unselect" any category, select
it again; the toggle action will remove the "X", and the selection.

Finally, you have the option of selecting "Cancel" or "OK", using the buttons in the upper
right corner of the "Create An Event" screen. If you select "Cancel", the information you have
entered will not be changed or added to your database. When you select "OK", the information
showing on your "Add Event" screen will become part of your database. (Use the "Update"
function to change or add event information for anyone already entered in your database).



Options Menu

The Options Menu allows you to toggle your display of people to a display of company
names or Zip codes and to limit the events display to only selected events based on
selection criteria. There also also options for displaying amounts and customizing reports.
A checkmark next to an option indicates that the option is currently in effect. All checkmark
selection states are saved at program exit and are restored when you start the program
again.

For more information, select the Options menu command name.

Display Company
Display Zip Codes
Display Amounts

Customize Reports
Show Only Selected Events




Display Company

By selecting this feature, you "toggle" PMS into a mode that will present the Company
name (entered during the Add Person function) as primary; Company names will appear on the
main screen , instead of individuals' names. If any person in the database does not have a
Company name, that person's name will appear as primary on the screen. To enter the
"Display Company " feature, tab to highlight it and press your "Enter" key, or select with your
mouse cursor and press the left mouse button. Use this feature for browsing or searching
through records using the Company name, instead of the person's name. PMS will resort the
database so that your display is still in alphabetical order. A checkmark will appear to the left of
the "Display Company" option while it is selected. To avoid toggling the "Display Company"
feature, tab back out of that menu option, or point your mouse cursor outside the menu option.
Although the presentation of Company names should make it obvious that this feature in
enabled, you may also select the "Options" menu, and look to see if there is a checkmark to the
left of the feature. When the checkmark appears, the feature is enabled.

When Display Company is enabled, any reports produced will be in Company sort order and
the Use Company Name checkbox in the Customize Reports screen will be checked.



Display Zip Codes

By selecting this feature, you "toggle" PMS into a mode that will present the Zip Code
and person's last name in the People Box on the main screen, instead of individuals' names.
To enter the "Display Zip Codes " feature, tab to highlight it and press your "Enter" key, or select
with your mouse cursor and press the left mouse button. Use this feature for browsing or
searching through records using the Zip Code, instead of the person's name. PMS will resort the
database so that your display is still in numerical/alphabetical order. A checkmark will appear to
the left of the "Display Zip Codes" option while it is selected. To avoid toggling the "Display Zip
Codes" feature, tab back out of that menu option, or point your mouse cursor outside the menu
option. Although the presentation of Zip Codes should make it obvious that this feature in
enabled, you may also select the "Options" menu, and look to see if there is a checkmark to the
left of the feature. When the checkmark appears, the feature is enabled.

When Display Zip Codes is enabled, any reports produced will be in Zip Code sort order.
This will make label printing print labels in Zip Code Order.



Display Amounts

When this feature is enabled, four new fields will be displayed on the main screen.
The word Amount maybe replaced by using the FILE SETUP SYSTEM PARAMETERS menu
option.
Total Amount - People List

This value represents the summation of individual amounts from the Person records
for the people in the list. If the entire database is selected, then this amount would reflect
the summation of all Person records.
Total Amount - Event List

This value represents the summation of individual amounts from the Event records
for the selected Person. If Show Selected Events option is turned off, This amount should
equal the Amount - Selected Person.
Amount - Selected Person

This value is the amount value from the selected person's Person record and should
represent a summation of all events for this person.

Amount - Selected Event

This value is the amount value from the selected Event record.



Customize Reports

Selecting this option will enable report customization. When this option is on and
you select a report to print, you will be presented with a screen that will allow you to select
how the report headers will look and what data should appear on the reports. Default
values are presented based on the report selected and the options currently in effect. You
may make changes and press OK to produce the report, or you can save your changes and
they will become the new default for printing the report (even if Customize Reports option is
off). This will allow you to customize the reports once and forget about the headers in the
future.



Show Only Selected Events

This feature will allow you to show only the events that are subset list criteria on your
main PMS screen. You will not be able to browse or update events that are not part of the
selected event criteria. "Show Only Selected Events" is selected by tabbing to this feature and
pressing your Enter key, or by placing your mouse cursor on it and pressing the left mouse
button. You may select the "Options" menu at any time, to see if this option in enabled, or not.
To unselect, simply select again. Because it may not be so obvious that this feature is enabled, a
message stating "Selected Events" will appear just below the "# of # Records Selected" box near
the top of your screen. When the "Selected Events" message appears, the feature is enabled,
and complete event records will not show on your screen.






Reports Menu

PMS offers nine basic report styles, with numerous variations possible. Since most of the
reports offer the ability to be produced from subset lists (in addition to the complete PMS
database), the list of available reports is actually endless. In addition, there are three label
formats for you to choose from. Reports are designed to get much of the data in your database
to "hard copy", for the ease of viewing by others. As you gain experience in developing subset
lists, with these reports in mind, you will learn to ask questions about the people information in
your PMS database that you may have never thought of before. The reports are geared to
providing top-level "management" decision-making information.

Each report will bear the "System Title" ( the name you gave your database during setup),
the date the report was produced, and the time of day the report was produced. Since your
database is always changing, it is important to know when the report was produced.

While each report is printing, you have the option of cancelling the individual report, by
selecting the "Cancel Printing" option that will appear in the center of your screen.

Detail Reports
Summary Reports

Labels




Detail Reports

The first group of reports allow to you to print detailed information. These reports are
designed to give as complete information as possible to persons not able to view the data on the
computer. They also assemble data not easily discernable from viewing a database file. You will
find that the questions you ask when you decide to produce a report will govern the quality of the
actual report. The structure of some of the reports may actually give you some creative ideas
about how to think about the information in your database.

Detail Reports will automatically start a new page for each person. If the report calls for
more than one page for an individual, PMS will still start the next report on a fresh page. Fora
look at the report forms, see "SAMPLE REPORTS " section in the "APPENDIX".

Detail History (Person)

Detail History (Subset)

Activity for Date Range
Last Activity




Detail History (Person)

This report will print out almost everything your PMS database knows about the
individual. It includes the individuals' name, his company (if any), the primary address, all phone
numbers, all People Categories selected for the individual, personal comments recorded, and
copies of each event involving the individual. Each event will show type of event (including
Event Category, if you selected one), a title for the event, time & date event occurred, and
comments you recorded about the event. If the individual has many events, this will be a long
report; the kind a reader would want if he needed all the information that was available.
Secondary addresses will not be printed in this report, unless you "toggle" the addresses to make
them primary. The report header will read "Detail History Report".

Example



Activity for Date Range

This report will produce all the details for a selected subset of names in your PMS
database, for a specific date, or for activity between two dates (a date range). This report is a
compilation of "Individual History Reports", for a subset of people selected by your criteria; but
only for a specific date or specific date range. By setting the beginning date to be the same as
the ending date, you may produce a daily report. The report header will read "Activity Detail
between <date> and <date>".

Example



Example Activity for Date Range Report

QUICK START COMPANY Sat 10/26/91
10:06
Detail History Report
Mr. Andrew A. Adams Pres. Home Phone: 1-(589) 555-1212
ADAMS APPLES Bus. Phone: 1-(589) 655-
9853
1034 West Covina Ave. Fax Phone: None

San Francisco, CA 65897

People Categories: Prospective client Retail Firm

President of Adams Apples - a firm employing approx 25 persons. Principal activity is
wholesale fruit distribution.

07/09/91 03:05 PM Called to discuss over services.

Event Categories: Estimate prepared
He asked some specific questions about how our market studies are done, how long they
take, and what the cost might be. He will call back later. Sent estimate for preliminary
market study.
06/18/91 11:50 AM Open file. Prospect.

Event Categories: File opened
Met Mr. Adams on the golf course. He may call for more info on our company.



Last Activity

This report will show only the last event for each person you select in your PMS database.
The report will show you the "pulse" of activity of your database. None of the detail for the
individual is left out; only multiple events, if they exist. The report header will read "Last
Activity Detail Report".

Example



Example Last Activity Report

QUICK START COMPANY Sat 10/26/91
10:10
Last Activity Detail Report
Mrs. Alicia A. Andrews CEO Home Phone: 1-301-992-6532
ATTITUDE ADJUSTERS, INC. Bus. Phone: 1-202-321-9587
5548 W. Third Avenue Fax Phone: 1-202-663-3451
Washington, DC 25894
People Categories: Client-Full billing Service Business
(Open)

Alicia is a friend of Sue Downs, who referred her to us for cash flow
projections. She is experiencing too much month at the end of her budget, and may need
to find some ways to borrow operating capital until her business takes off.

11/22/91 11:00 AM Payment received.
Event Categories:



Detail History (Subset)

This report is a continuous printing of "Detail History (Person)" reports for each person in
the subset selected by your criteria. Failure to first select a subset will give you a report for each
person in your PMS database (if you have a large database, this could take some time). The
report header will read "Detail History Report".

Example



Example Detail History Report

QUICK START COMPANY Sat 10/26/91
10:05
Detail History Report
Mrs. Alicia A. Andrews CEO Home Phone: 1-301-992-6532
ATTITUDE ADJUSTERS, INC. Bus. Phone: 1-202-321-9587
5548 W. Third Avenue Fax Phone: 1-202-663-3451

Washington, DC 25894

People Categories: Client-Full billing Service Business

Alicia is a friend of Sue Downs, who referred her to us for cash flow
projections. She is experiencing too much month at the end of her budget, and may need
to find some ways to borrow operating capital until her business takes off.

11/22/91 11:00 AM Payment received.
Event Categories:

11/15/91 09:00 AM Settlement on Line of Credit.
Event Categories: Project Completed
Will pay in seven days.
10/30/91 02:50 PM Loan approved.
Event Categories: Loan approved
First Union said "yes". Interest of 13% over 5 years with 2 points.
Min.repayment 5% of outstanding balance. Settlement on 11/15/91.
10/21/91 08:49 PM Loan submitted.
Event Categories: Loan submitted
To: First Union, BankAmerica, & Bolton Pension Fund
10/18/91 02:45 PM Loan package received.
Event Categories: Loan package done

10/12/91 08:46 PM Conference re: cash flows. Signed for line of credit
Event Categories: Contract signed Projected Cash Flow
Current Cash Flows

Appears to warrant borrowing of a $45,000 line of credit.

10/02/91 11:45 AM  Open file. Needs cash flow studies.

Event Categories: File opened

Sent brochure.



Summary Reports

Summary Reports offer less detail than the reports listed above; they are geared to print
out only the information you really need, and do not show personal comments about people or
events.

Activity Summary
Last Activit
Activity for Date Range

People in Subset
Database Statistics




Activity Summary

This report shows the criteria used to select the subset, each activity on record for those
on the subset list, the time & date for each event, and the title you gave to each event. The
report header will read "Activity Summary".

Example



Example: Activity Summary

QUICK START COMPANY
10:11
Activity Summary
Selection by Person - Any of the following categories
Lawyer

Mr. Clinton C. Chase Esq.

09/14/91 03:40 PM  Came to office to meet with John
08/16/91 04:30 PM  Lunch with John.

06/03/91 03:50 PM  Conference with Mr. Chase.
05/10/91 02:00 PM  Open file. Resume received. Local

Mr. Edward E. Edgerly Esq.
08/18/91 10:00 AM  Open file. Received resume. PA. (Pittsburgh)

Mr. Michael M. Moonstruck Esq.
10/23/91 04:10 PM  Stopped by our office to introduce himself.
10/18/91 10:07 PM  Open file. Legal/settlements. Local.

Mr. Peter P. Phillips Esq.
06/22/91 11:00 AM  Open file. Business card on file. Miami

Mr. Vance V. Vanderhood Esq.
05/26/91 01:00 PM  Open file. Business card on file. Local

Sat 10/26/91



Last Activity
This report shows the criteria used to select the subset, and only the last event for each

person in the subset list; including the time & date the last event occurred, and the title you gave
the event. The report header will read "Last Activity Summary".

Example



Example: Last Activity (Summary)

QUICK START COMPANY
10:12
Last Activity Summary
Selection by Person - Any of the following categories
CPA

Mr. Carl C. Chamberlin
08/03/91 08:50 AM  Open file. Received resume. Georgia.

Mr. Clinton C. Chase Esq.
09/14/91 03:40 PM  Came to office to meet with John

Mr. Felix F. Farnsworth Esq.
07/18/91 10:00 AM  Open file. Received resume. Alabama

Sat 10/26/91



Activity for Date Range

This report allows you to select a subset, and then show all events on a particular
date, or between two dates (a date range). It shows the selection criteria, the individuals'
names, date & time of events, and the titles you gave the events. If you do not choose to
create a subset, this report will function for a "daily report"”, or "monthly summary" for the
entire database. The report header will read "Activity Summary between <date> and
<date>".

Example



Example: Activity for Date Range (Summary)

QUICK START COMPANY Sat 10/26/91
10:35
Activity Summary between 10/01/91 and 10/15/91
Selection by Person - Any of the following categories
Client-Full billing

Mrs. Alicia A. Andrews CEO
10/12/91 08:46 PM  Conference re: cash flows. Signed for line of credit
10/02/91 11:45 AM  Open file. Needs cash flow studies.

Mrs. Catherine C. Carter V.P.
10/10/91 09:30 AM  Loan submitted.
10/06/91 01:30 PM  Conference with Ms. Carter re: loan package.

Mr. Donald D. Downes Genl. Mgr.
No Activity

Mr. George G. Gordon Owner
No Activity

Ms. Kathy K. Kraus
No Activity

Mr. Leo L. Lindstrom V.P.
No Activity

Mr. Nicholas N. Nero Partner
10/15/91 10:00 AM  Conference re: inventory financing.
10/08/91 02:55 PM  Open file. Called re: inventory financing.

Mr. Ned N. Norris Owner
No Activity

Mr. Orville O. Otis Pres.

10/15/91 11:26 AM  SBA approved loan.

10/09/91 10:10 AM  Sent letter to Regional SBA re: credit error.
10/05/91 03:15 PM Loan rejected.

Mr. Sheldon S. Smith
10/15/91 02:15 PM  Settled on loan.

Mr. Thomas T. Trump Owner

10/15/91 02:45 PM  Loan submitted.

10/08/91 08:45 AM  Conference with Mr. Trump re: package done.
10/01/91 09:30 AM  Signed for equipment loan packaging.



People in Subset
This report will show the selection criteria for the subset, and then list only the names of

those in the subset (example: Board Members; volunteers; Committee Chairpersons, etc.) The
report header will read "People In Subset Summary".

Example



Example: People in Subset

QUICK START COMPANY Sat 10/26/91
10:15
People in Subset Summary
Selection by Person - Any of the following categories
Independent Contr.

Mr. Byron B. Bloodsworth
Mr. Horace H. Hafftone
Mr. Victor V. Vorhees

Mr. Walter W. Wheeler
Mr. Winchell W. Wright



Database Statistics

This report lists the total number of people in your database, the total number of events in your
database, and the quantity in each "People Category" as well as the quantity of each type of
"Event Category" that has been selected. The report header will read "Database Statistics

Report".

Example



Example:

QUICK START COMPANY

Database Statistics

KBS: PMS - Database Statistics Report

Total People on File

Count of People
Employee
Independent Contr.
Volunteer
Client-Full billing
Client-Partial bill
Prospective client
CPA

Lawyer

Banker
Government Agency
Committee member
Contributor
Service Business
Wholesale Firm
Retail Firm
Restaurant/Hotel
Non-profit Agency
Educational

(Open)

(Open)

0

=

Categories

4 File opened
Estimate prepared

4 Contract prepared

11 Contract signed

4 Contract rejected
Demographics done

3 Projected Cash Flow

5 Current Cash Flows

3 Profit/Loss Analys
Market study done
Balance Sheet Analy

4 Loan package done
Loan submitted
Loan approved

5 Loan rejected
Project Started
Project Completed

1 Follow Up Sent

0 Follow Up Returned

0 (Open)

Total Events on File 117

0

Mon 10/21/91 23:30

Count of Event Categories

47
2

0

[

12






Labels

With this feature, you select those you wish to make labels for, by any selection criteria
you choose, and select "Labels" from the "Reports" menu. Labels are available in the three

most popular formats:

Labels - 1 Up
Labels - 2 Up
Labels - 3 Up



Labels - 1 Up

Bruce B. Baker
156 Second Street
Del Ray, FL 31558

Byron B. Bloodsworth
3562 St. Martins Road
Marco Island, FL 34588

Horace H. Hafftone
HAFFTONE MARKET DATA
954 Bridge Road

Atlantic City, N)] 36958

Jerry J. Jardin

QUICK START COMPANY

22 Duck Lane

Dames Quarter, MD 21855

Kelly K. Kendall

QUICK START COMPANY
15 Merry Lane
Goodland, FL 33588

Larry L. Lang

QUICK START COMPANY
522 Caribou Circle
Marco Island, FL 33588

Linda L. Lyons

LYONS PERSONNEL SERV.
258 Monk Court

Marco Island, FL 34588

Martin M. Meford
QUICK START COMPANY
544 Ten Eyck Avenue
Goodland, FL 33588

Richard R. Righter
653 Mountain Road
Marco Island, FL 34588






Labels - 2 Up

Andrew A. Adams

ADAMS APPLES

1034 West Covina Ave.
San Francisco, CA 65897

Doug Darling
258 Citrus Circle
Annapolis, MD 21855

Fred F. Feeble

FIRST UNION BANK
2200 Financial Square
Asheville, NC 33445

Gary G. Grier
6589 Sunshine Terrace
Marco Island, FL 34588

Iris I. Isabella
IMMANENT ISSUES
354 Montrose Avenue
Lawton, PA 21548

Marilyn M. Monfort
Marco Island, FL 34588

Thomas T. Trueblood
TRAILERS & TOPS

665 Shorline Drive
Marco Island, FL 34588

David D. Damon
526 Butler Court
Marco Island, FL 34588

Ernest E. Endicott

ENDICOTT & CO.

954 East Berlin Road
Dover, DE 22801

Gregory G. Gissell
652 Relaxing Road
Wheeling, WV 26584

Henrietta H. Harding

SBA South Region

1500 Federal Building
Washington, DC 22150

John J. Jones

JUST JONES JALOPIES
66 Mockingbird Lane
Suitland, MD 21995

Oscar O. Owings

OWINGS & ASSOCIATES
3630 So. Parin Way
Vero Beach, FL 33547



Labels - 3 Up

Andrew A. Adams

ADAMS APPLES

1034 West Covina Ave.
San Francisco, CA 65897

Catherine C. Carter
CATHY'S CANDIES

1500 Industrial Rd

Marco Island, FL 333927

Felix F. Farnsworth

FARNSWORTH & ASSOC.,P.A.

1250 S. Main Street
Bakersfield, AL 66548

Iris I. Isabella
IMMANENT ISSUES
354 Montrose Avenue
Lawton, PA 21548

Leo L. Lindstrom
LINDSTROM LIGHTING
542 Separate Drive
Naples, FL 33588

Orville O. Otis
ORTHODONTICS BY OTIS
663 Main Street

Ft. Lauderdale, FL 33699
65897

Sheldon S. Smith

SS SMITH'S SEAFOOD
1400 Pallisades Ave.
Marco Island, FL 34588
33487

Alicia A. Andrews

Bonnie B. Butler

ATTITUDE ADJUSTERS, INC. BUTLER BONDING

5548 W. Third Avenue
Washington, DC 25894

Carl C. Chamberlin

CHAMBERLIN ACCOUNTING

6520 Reservoir Road
Atlanta, GA 28555

George G. Gordon
GORDON'S GOODIES
1245 Baker Lane
Columbia, SC 55421

John J. Jones

JUST JONES JALOPIES
66 Mockingbird Lane
Suitland, MD 21995

Nicholas N. Nero
NATURAL NUTRITION
1250 Straight Street
Naples, FL 33590

Patricia P. Porter

PORTER PLASTICS, INC.

1600 Plainfield Drive
Orlando, FL 34588

Thomas T. Trueblood
TRAILERS & TOPS
665 Shorline Drive

Marco Island, FL 34588

2590 Main Street
Orlando, FL 31552

Donald D. Downes

DAKOTA DOZERS

6635 Power Court
Detroit, M| 98552

Ira . Irvings

IRVING INK PADS

95 Morris Avenue
Morristown, NJ 55841

Kathy K. Kraus

KLOSETS BY KRAUS

1500 Joiner Avenue
Ft. Lucie, FL 33588

Ned N. Norris

NIGHT NOTIONS

652 Windmill Drive
Allendale, FL 33687

Sonny S. Shapiro

SUBURBAN SUNLMP

1526 West Boulevard
San Franc, CA

Thomas T. Trump
TREE TRIMMERS

26 Cedar Way
BocaRaton, FL









What is Quick Start

QUICK START COMPANY is a consulting firm providing business services to small and
medium size companies. They have employees, and also use independent sub contractors to
supply studies, analyses, and advice on various business matters. Some of the services they
provide are complete cash flow analyses, marketing and demographics research, and
preparation of loan packages when the need is indicated by their research. They also advise on
federal and state tax matters.

For small businesses that cannot afford necessary services, QUICK START uses a
volunteer base from the community, S.C.O.R.E. (Service Corps of Retired Executives), and local
college students (as class projects or assignments). These clients pay reduced rates that their
business can support.

They have been using KBS: People Management System for about six months now,
and are not sure what information will be available by using the system. QUICK START
COMPANY has asked their employees and volunteers to assemble a list of questions that might
be answered by a comprehensive database. The list is attached.

QuickStart Questions #1 - About Individual People in the Database
QuickStart Questions #2 - About Groups (Subset Lists)

QuickStart Questions #3 - Information By Date or Date Range(s)
QuickStart Questions #4 - Reports Desired

QuickStart Questions #5 - Creative Searches and Reports

Quick Start and Dealing with Values
QuickStart Questions #6 - About Individual People in the Database
QuickStart Questions #7 - About Groups (Subset Lists)

QuickStart Questions #8 - Information Through Reports
QuickStart Questions #9 - Creative Use of PMS




Quick Start Questions - Category #1 - About Individual People in the Database

Is John J. Jones in our Database?

What is his Address?

What is his business phone number?

Is he a CPA?

When was the last time we had contact with Mr. Jones?

When was his file opened?

Is SUBURBAN SUNLAMPS in our database?

What is the name of our contact person with that firm?

What is his home phone number?

On what date did we complete our project with SUBURBAN SUNLAMPS?

What happened at the 6/18 conference with Mr. Sonny Shapiro?

Byron Bloodsworth is an independent contractor. What is his area of specialty?




Is John }. Jones in our Database?

Hint
Answer
Procedure



What is his Address?

Hint
Answer
Procedure



What is his business phone number?

Hint
Answer
Procedure



Is he a CPA?

Hint
Answer
Procedure



When was the last time we had contact with Mr. Jones?

Hint
Answer
Procedure



When was his file opened?

Hint
Answer
Procedure



Is SUBURBAN SUNLAMPS in our database?

Hint
Answer
Procedure



What is the name of our contact person with that firm?

Hint
Answer
Procedure



What is his home phone number?

Hint
Answer
Procedure



On what date did we complete our project with SUBURBAN SUNLAMPS?

Hint
Answer
Procedure



What happened at the 6/18 conference with Mr. Sonny Shapiro?

Hint
Answer
Procedure



Look for him in the "people list" on your main PMS screen



Yes.



Highlight or click your mouse on any person in the "People List". This is the list that begins
with "Adams, Andrew, A.". Use the scroll bar at the right to go down the alphabetical people list
to the J's, or for more speed, type a "J" on your keyboard. Continue going down the list till you

come to his name (or the absence of it).



Select "Update" above "people list".



66 Mockingbird Lane, Suitland, MD



When you find his name, highlight it. Then, select the "Update" button above the people list; the
"People Update" screen will appear. You may read his address there, and then select "Cancel" to

go back to the main screen. A faster way to get the People Update screen is to double click on
Mr. Jones's name.



Select "Update" above "people list".



1-(202) 659-8847



Double click on Mr. Jones's name again to read the phone number. Select "Cancel" to return to
the main screen. Itis a good habit to select "Cancel" on any screen you look at without making
any changes. If you inadvertently make an entry with the or keyboard, you will not change any
of your database records by mistake.



Select "Update" above "people list".



No.



Again, double click Mr. Jones's name, or select the "People Update" button. Look at the "people
categories" on the right side of the screen. You can see that he is a "prospective client", and
also a "Retail Firm". But, he is not a "CPA". Whenever you search this database, you can find
Mr. Jones by asking for a subset list including either "prospective clients", or "Retail Firms".
When you set up your first PMS database file, you will be asked to name these 20 categories.

You should choose categories that your business or organization recognizes as normal in your
business.



Look in the "event list" on the bottom of your main PMS screen.



July 13, 1991 at 10:00 am.



On the main PMS screen, highlight Mr. Jones. Look at the bottom of the screen in the "Events
Box". All events entered into your database involving Mr. Jones will appear there, in reverse
chronological order, by date; If there are multiple events, the last one will be on top of the list.
There has only been one contact with Mr. Jones. The date and time appear on each event; then
the words that follow, which are his "Event Title'. Each time you add an event to your PMS
database, you will be asked to provide an event title. You should choose the words that you
want to appear on the main screen when his name is highlighted. You will also have the
opportunity to record comments or details about the event which will not appear on the main
screen until you go get them.



Select the "Update " button at the bottom of your main PMS screen.



July 13, 1991.



Althought the listing in the event box for Mr. Jones does not supecifically say so, since there is
only one event, one might assume his file was opened on that date. This may, or may not be
true. Highlight the event, and select the "Update" button to the right of the event box. The
Event Update screen will appear, and you will see that "File Opened" is checked. Now you are
sure. You may want to include a category like this when you set up your first PMS database; as
you get to select all 20 categories to match your business or organization needs. A faster way to
get the "Event Update" screen is to double click on the event. To return to the main PMS screen,
select "Cancel".



Select "Display Company" under "Options" menu, and find on the "people list".



Yes.



Select "Display Company" from the "Options" menu. The people list changes. It now lists
company names in alphabetical order. If the person in your database did not have a company
name when it was entered into the database, his name will appear on the people list (instead of a
company name). Highlight any name in the people list. Now scroll to the "S"'s or enter an "S"
from your keyboard. Continue down the list to see if there is a 'SUBURBAN SUNLAMPS". There
is.



Select "Update" above "people list".



Mr. Sonny Shapiro.



Highlight "SUBURBAN SUNLAMPS" in the people list. Now, double click his name, or select the
"Update" button above the people list. The "People Update" screen will appear. You will see Mr.
Shapiro's name, his company name, and the balance of the information that was added to the
database through the "Add Person" function under the "Maintenance" menu (or by Import).
Leave the People Update screen by selecting "Cancel". You will be returned to the main PMS
screen.



Select "Update" above the people list.



1-(556) 693-2213.



Double click "SUBURBAN SUNLAMPS" to enter the People Update screen. After you read his
home phone number, select "Cancel" to return to the main PMS screen. Note that whether you
are displaying the company names, or the individual's names, all "people" information comes
from the same screen. Regarding the home phone number you just verified, you can autodial
Mr. Shapiro at his home at any time without entering the phone number. PMS will do it
automatically for you; and will also dial the business or fax number. One word of caution here:
be sure to enter the phone numbers in the form that your modem requires. Many modems
require a particular format, like "1-301-654-9999", or "1(301)654-9999".



Go to the "event list" on lower part of main PMS screen.



June 18, 1991.



Look at the events that arelisted in the event box at the bottom of your screen when you have
"Mr. Shapiro" or "SUBURBAN SUNLAMPS" highlighted. Again, you cannot be sure that the last
contact is when the project was completed (he may have contacted you after it was completed).
Try double clicking the first event on the list (the one with the most recent date). The Event
Update screen will appear, and in checking the event categories at the right of this screeen, you
see that there is a checkmark next to the "Project Complete" category. Select "Cancel" to return
to the main PMS screen.



Use the Event Update screen.



We discussed cash flows, and he is satisfied. Project complete.






Quick Start Questions - Category #2 - About Groups (Subset Lists)

How many lawyers are there in our database, and who are they?

Are there any lawyers who also hold the title of "CPA"?

Determine how many lawyers in our database are NOT CPA's; and their names.

Determine a list of all persons connected with government agencies; and list them by their
agency names.

Determine a list of all clients that are not being billed full rates.

Determine a list of all companies for whom we have done Projected Cash Flows.

Restrict the names in the "people list" on the screen to those who are not employees, and not
independent contractors, nor volunteers.

How many prospective clients are we working with at this time?

Name all the people for who we have both submitted loans, and those loans were approved.

How many people have signed contracts with us, but the projects are not yet checked "complete"
and who are they?




Byron Bloodsworth is an independent contractor. What is his area of specialty?

Hint
Answer
Procedure



How many lawyers are there in our database, and who are they?
Hint

Answer

Procedure



Are there any lawyers who also hold the title of "CPA"?
Hint

Answer
Procedure



Determine how many lawyers in our database are NOT CPA's; and their names.
Hint

Answer

Procedure



Determine a list of all persons connected with government agencies; and list them by
their agency names.

Hint

Answer

Procedure



Determine a list of all clients that are not being billed full rates.
Hint

Answer

Procedure



Determine a list of all companies for whom we have done Projected Cash Flows.
Hint

Answer

Procedure



Restrict the names in the "people list" on the screen to those who are not employees,
and not independent contractors, nor volunteers.

Hint

Answer

Procedure



How many prospective clients are we working with at this time?
Hint

Answer

Procedure



Name all the people for who we have both submitted loans, and those loans were
approved.

Hint
Answer
Procedure



How many people have sighed contracts with us, but the projects are not yet
checked "complete”, and who are they?

Hint
Answer
Procedure



Don't take the easy way. This question could be asked about any person in your database; it just
so happens that we are looking closely at SUBURBAN SUNLAMPS, and Mr. Shapiro. Go to the
"Options" menu and select it. You will see a check mark next to"Display Company". Although it
is fairly obvious with the Quick Start Company database to see that you are in the "Display
Company" mode (all his companies were entered with capital letters), you may check at any time
by looking here. When there is no check by "Display Company", the display is set on individuals'
names. Select "Display Company" now. The check mark is gone, and the people list now shows
personal names, in alphabetical order. Find Sonny Shapiro, and highlight his name. Now look
at the event title for 6/18, in the event box at the bottom of the main PMS screen. All it tells you
about the 6/18 event is that is was a conference, on that date, and the time of the conference
was 4:00 p.m.. To get further information, double click the 6/18th event, or select the Event
Update button to the right of the event box. You will see the same title that appeared on the
main screen. Just below it is the "Event Comments" box, where it has been recorded that the
subject matter of the conference was cash flows. And, he is satisfied. To the right of this screen
are the 20 Event Categories. The one check for this event is "Project Completed". This
information was put into QUICK START COMPANY's database by the "Add Event" function. The
event comments could have been up to approximately 1,000 characters. Any information could
have been entered, and yet only the event title will appear on the main PMS screen. When the
event comments exceed the amount that can be shown on your screen, scroll bars will appear to
the right of the comments box, so you can read the enter comments recorded. Multiple Event
Categories could have been checked. You may search by these categories when you develop a
"working database" by using "Subset Lists". If you selected the Event Update button without
first selecting (highlighting) the event, you got an error message reminding you to select the
event you wish to see the information on.



Check the "People Comments" box.



Commercial real estate consulting.



Find Byron Bloodsworth in the people list, and highlight his name. Look to the right, and you will
find some notes about Mr. Bloodsworth that answer the question. This area of the screen is
called the "People Comments" or "Personal Comments" box. The comments recorder here may
be entered at any time by tabbing to or clicking anywhere on this box. The comments appear
only when the individual's name is highlighted. They may be as long as 1,000 characters, and
long comments may not be all visible on one screen. When they exceed screen length, a scroll
bar will appear to the right of the comments box, so you can read the entire comments box
contents.



Select "People - Any Check" from "Subset List" menu.



There are five. Chase, Edgerly, Moonstruck, Phillips, and Vanderhood.



Select "Subset List" from the menu bar at the top of your main PMS screen. Select "People - Any
Check"; and a subset list screen will appear. This is the "People Subset" list. On it your will see
listed the 20 checkboxes you saw before, when you used the People Update function. There are
two series of boxes; "Yes" boxes, and "No" boxes. The header on this screen reads "Match any
Check", and that is what PMS will do. Tab to the "Yes" box next to "Lawyer", and hit your space
bar, or point to the box with your mouse cursor and click once. An "X" will appear in the box you
have selected. PMS has all the information needed from you to develop a subset list, that will
only list the people in your database that have been checked "Lawyer". Select the "OK" button on
that screen, and watch what happens. The box in the top center of your screen that read "50 of
50 Records Selected" now reads "5 of 50 Records Selected". Just below that box, the message
"Full Database" has changed to "Subset", so you know you are limited to a "working database".
The names in the people list has been reduced to lawyers; five of them. And, there is one more
change; a new box has appeared on the top right (just under the "Options" menu), that reads
"People - Any Check". It also has a drop box. Click on the drop box. As long as you are in this
subset, you may come here at any time to verify exactly what search criteria the subset is based
on: People Any Check -Lawyers. To remove the drop box, click on the drop box arrow again, or
click or tab anywhere on the screen. Click on any lawyer's name, and his personal comments and
events appear in their respective boxes.



Select "People - All Checks" from "Subset List" menu.



One. Clinton C. Chase.



If you click on Mr. Chase's nhame, and look to the right of his name in the personal comments box,
you will see that it mentions that he is a CPA. However, he may not be the only one. Since both
"lawyer" and "CPA" are People Classifications, there is a way to answer the question definitively.
Select the "Subset List" menu. Then select "People - All Checks" and a subset list screen will
appear. This is the "People Subset" list. On it your will see listed the 20 checkboxes you saw
before, when you used the People Update function. There are two series of boxes; "Yes" boxes,
and "No" boxes. The header on this screen reads "Matches All Checks", and that is what PMS
will do. Tab to the "Yes" box next to "Lawyer", and hit your space bar, or point to the box with
your mouse cursor and click once. An "X" will appear in the box you have selected. Now do the
same for "CPA"; put an "X" in the 'Yes" box next to that title. PMS has all the information
needed from you to develop a subset list, that will only list the people in your database that have
been checked "Lawyer" and also "CPA". Lawyers that are "Not" CPA's will not be part of the
subset. CPA's that are not lawyers will not be part of the subset list. Only those persons who
match ALL checks will be part of the subset. Select the "OK" button on that screen, and watch
what happens. One one record is selected. and that is Clinton C. Chase, Esq.. Double click his
name in the people list, and look at the People Update screen. You will see that both boxes are
checked. Select "Cancel". Now click on the drop box that says "People - All Checks", and verify
the search criteria.



Select "People - Any Check" from "Subset List" menu.



Four; Edgerly, Moonstruck, Phillips, and Vanderhood.



With your deductive reasoning, you could answer this question without the help of PMS's search
criteria. But, the questions are not always this easy. The real question is, how can | develop a
subset list with this criteria: Yes, he is a lawyer; No he is not a CPA. Select "Subset List" from
the menu. Click an "X" in the NO box for CPA. Click an "X" in the Yes box for Lawyer. Select
"OK". PMS has used positive and negative inquiry criteria. Click on the drop box again to see
how the search criteria is displayed.



Select "People - Any Check" from "Subset List" menu. Then, select "Display Company" from
"Options" menu.



There are two. Henrietta Harding with the SBA, and Ronald Ripkins with Collier Planning.



Select "Subset List" from the menu. Select "People - Any Check". Put an "X" by the Yes box
next to "Government Agency". Select "OK". Now you will see the two people. Select "Options"
from the menu bar. Select "Display Company". Now you will see their agencies. You may use
the "Company Name" entry however you wish when you are adding people to your database.
[You may find some creative use for this function if company names are less important to you. It
is possible to use the primary name for each company, and record the contact's name in the
personal comments box. Each time you click on the company name, the contact's name will be
visible to the right ; in the personal comments box. This would allow you to use the Company
Name for any alpha-numeric input you wish to have as an alternate display.]



Select "People - Any Check" from "Subset List" menu.



There are four: Butler, Irvings, Porter, and Shapiro.



QUICK START COMPANY is set up to differentiate between full billing and partial billing clients.
They have done this by using the People Categories, and checking the one that applies for each
client. Select "Subset List" from the menu. Select "People - Any Check". Putan "X" in the Yes
box next to "Client -Partial bill". Select "OK". If you don't see the individuals' names, you did
not undo the "Display Company" feature under the "Options" menu. Do so now.



Select "Event - Any Check" from "Subset List" menu.



There are eight: ATTIDTUDE ADJUSTERS, CATHY'S CANDIES, LINDSTROM LIGHTING, NATURAL
NUTRITION, ORTHODONTICS BY OTIS, PORTER PLASTICS, SMITH'S SEAFOOD, and SUBURBAN
SUNLAMPS.



Select "Subset List" from the menu. Select "Event - Any Check"; the "Subset List for Events"
screen will appear. Put an "X" in the Yes box next to "Projected Cash Flows". Select "OK". PMS
will search through each person's file, and if he has a check next to "Projected Cash Flows" (in
any of the events for any person), PMS will make him part of the subset list. The subset list
shows you eight people in the people lists. Since the question asks for "companies", select
"Display Company" under the "Options' menu.



Select "People - All Checks" from "Subset List" menu.



There are 37 people in the list.



These criteria are "People Categories". Select "People - All Checks" from the Subset List menu.
Put an "X" in the No boxes for "Employee", "Independent Contractor" and Volunteer". Select
"OK". If you show 37 companies, you did not reset the "Display Company" feature. If QUICK
START COMPANY wanted to send a company newsletter to everyone except employees,

independent contractors, and volunteers, they could print mailing labels from the current subset
list, and accomplish this.



Select "People - Any Check" from "Subset List" menu.



Four: Adams, Isabella, Jones, and Trueblood.



It should be getting easier by now. "Prospective Client" is a people category, so select "People -
Any Check" from the "Subset List" menu. Put an "X" by "Prospective Client", and select "OK".
Don't forget to restore to full database. If "Prospective Client" was one of your categories, it
would be important to remember to update the information on his people screen when he
became an actual client. You may update people and event information as often as you want.



Select "Event - All Checks"; select "Loan Submitted" and "Loan Approved".



There are five: Andrews, Carter, Norris, Otis, and Trump.



From the "Subset List" menu, select "Event - All Checks". When the "Matches All Events" screen
appears, put an "X" in the Yes box next to "Loan Submitted", and an "X" in the Yes box next to
"Loan Approved". Select "OK" to return to the main PMS screen.



Select "Event - All Checks"; select "Contract Signed" and check "No" for "Project
Complete".



There are three: Carter, Downes, and Otis.



From the "Subset List" menu, select "Event - All Checks". When the "Match All Checks" screen
appears, put an "X" in the Yes box next to "Contract Signed", and put an "X" in the No box next to
"Project Complete". Select "OK" to return to the main PMS screen. Any program is only as good
as the input; if the project was, in fact, complete, but the "Project Complete" category was never
checked, that person would be produced in this subset search. Once you get use to PMS, you
will be able to think of ways to periodically check the quality of input; there are some suggestions

in the manual.






Quick Start Questions - Category #3 - About Individual People in the Database

List all people in the database that were added between June 30, 1991 and September 30, 1991.

Structure the database information so that only events occuring after September 30, 1991 are
shown on the screen.

On what date did we complete the project for LINDSTROM LIGHTING?

List the firms for whom we have done a market study since October 1, 1991.

How many projects have been completed in the third quarter?

On date did we order the appraisal for Sheldon Smith?




List all people in the database that were added between June 30, 1991 and
September 30, 1991.

Hint

Answer

Procedure



Structure the database information so that only events occuring after September 30,
1991 are shown on the screen.

Hint
Answer
Procedure



On what date did we complete the project for LINDSTROM LIGHTING?
Hint

Answer
Procedure



List the firms for whom we have done a market study since October 1, 1991.
Hint

Answer

Procedure



How many projects have been completed in the third quarter?
Hint

Answer

Procedure



On what date did [so and so] do [such and such]?
Hint

Answer

Procedure



Select "Set Date Limits" from "Subset List" menu. Set date. Find "Files Opened".



There were 19 additions during this time period.



The first thing we need to do is to set the search date limits. Select "Set Date Limits" from the
"Subset List" menu. A pop up menu will appear entitled "Set Event Search Dates". To
change the dates to read June 30, 1991 (Start Date) and September 30, 1991 (End Date), follow
this procedure. Tab to the first field in the "Start Date" box, or click on it with your mouse cursor.
If you press the "delete" key on your keyboard, you may type the new month in this box. Or
alternately, you may use the scroll box on the right hand side of the box. When this field says
"6" (for June), tab to the day box and change it to read "30" by the same method. If the year s
correct, move your cursor to the "End Date" box, and use the same method to change the date to
read "09/30/91". Select the "Set" button to tell PMS you want that function "ON", and then
select "OK" to end the date set function. A message will appear above and to the right of the
people list that says "Date Set" to remind you that the date limit function is enabled. Now we
need to answer the question of who was added to the database during this time period. The
QUICK START COMPANY uses the Add Event function to mark files when they are first opened.
The check the box that says "File Opened" the "Subset List" menu, select "Event - Any Check".
When the Match Any Check PMS has searched each event in your database for ones that are
market "File Opened", but only between the date range you specified. Then he has listed the
names of the people that had the events in their files. There are 19 such people. Find Orville
Otis in the people list and highlight his name. Looking in the event box at the bottom of the
screen, you will see that he has eight events listed. None of them refers to the opening of his
file, so how did PMS make the selection? From the "Options" menu, select "Show Only
Selected Events". Now look at the event box - there is only one event which matches the search
criteria. To verify this, double click the event, or highlight the event and choose the Update
button to the right of the event box. You will see that the "File Opened" box is checked. This
feature (Show Only Selected Events) will help you find exactly what you are looking for, without
"wading" through unnecessary volumes of data. Select "Cancel" to leave the Update screen.
Now look on the top of your main PMS screen, in the center and below the box that now reads
"10 of 50 Records Selected". The message "Date Set" is to remind you that the date set function
is enabled. There is also a message that reads "Selected Events". This will remain there to
remind you of the mode you are in until you turn the function off. To leave this mode, select
"Show Only Selected Events" from the "Options" menu again. The check mark to the left of this
title will be removed, and so will the message in the center of your screen. Do this.



Select "Set Date Limits" from the "Subset List" menu. Select "Show Only Selected Events" from
the "Options" menu.



Yes, PMS can do it. The messages in the top center of your main PMS screen will read
"Date Set" and "Selected Events".



Select "Set Date Limits" from the "Subset List" menu. Using the procedure outlined previously
(Question #21), set the Start Date at October 1, 1991 ("after" 9/30/91). Set the End Date at
some date after the last database entry. | changed the year to read "1995", so it would be
obvious the next time | went to Set Date Limits. Select "Set" and "Select "OK". This will return
you to the main PMS screen. Under the "Options" menu, select "Show Only Selected Events".
Two messages will show in the top center of the main PMS screen: "Date Set" and "Selected
Events". To verify your success, click on "Adams, Andrew A." in the people list. No events
should show in the event box in the bottom portion of the screen. Now go back to the "Options"
menu, and again select "Show Only Selected Events". This will toggle the fuction "off", and you
will see an event below. The event was entered in the database on 6/18/91 - outside of the
search criteria of the question. Now click on "Andrews, Alicia A.. Seven events show in the
event box below. Go back to the "Options" menu and once more select "Show Only Selected
Events". The feature is toggle back "on", the message Selected Events" shows at the top of your
screen, and there is no change in the number of events that appear below. This is because all of
the event occured after 9/30/91; all are within your search criteria. To learn a little more about
"Set Date Limits", try the following procedure. Turn the "Show Only Selected Events" function
off; checking to make sure the "Selected Events" message in not showing in the top center of the
main PMS screen. Now "Event - Any Check" from the "Subset List" menu. Put an "X" in the Yes
box for "File Opened" and select "OK". Notice that Mr. Adams is no longer in your people list.
He was not selected because the event we chose did not occur in the date range named (the
"Date Set" message shows your date is still set). The reason he was on the list previously is
because you set the date when you had the full database in your "working database". That is
also why we used the "Show Only Selected Events" function in that instance. To develop good
PMS habits, you should go to the "Subset List" menu and select "Restore Full List", to bring your
"working database" back to the complete list. Go back to the "Subset List" menu and select "Set
Date Limits" to turn off the date limits. If your screen reads "Selected Events", go the the
"Options' menu and select "Show Only Selected Events" to turn that function off. Your database
is fully restored, with all limitations removed.



Select "Display Company" from "Options" menu.



September 22, 1991.



Since the question deals with a company name, rather than an individual, go to the "Options"
menu and select "Display Company". Your people list will now show company names. Highlight
any name and type an "L", or scroll down the list to "Lindstrom Lighting". Looking at his events
below, you cannot be certain if the  project was completed on the last contact date, so double
click the last event, or highlight the last event and select the Event Update button, to check the
Event Update screen. Yes, the "Project Completed" box is checked. Select "Cancel to return to
the main PMS screen. You could have found this answer using the "Event - Any Check" search in
the "Subset List" menu, together with the "Show Only Selected Events" function. The only
event that would have appeared would have been the one that corresponded to the search
criteria: the event that was checked "Project Completed". A similar example will be given
later in QUICK START.



Select "Set Date Limits" from "Subset List" menu; then "Event - Any Check"; then Select
"Display Company" from "Options" menu.



There is one: BUTLER BONDING.



Select "Set Date Limits" from the "Subset List" menu. Notice that the dates showing are
adequate for our search (Start date = October 1, 1991; End Date = some time in the future).
But, the dates are not "set". Select the "Set" button, and then select the "OK" button. Next,
select "Event - Any Check" from the "Subset List" menu. Put an "X" by the Yes box next to
"Market Study Done", and select "OK". Since we are looking for "firms", turn on the "Display
Company" function under the "Options" menu. "Restore Full List" under the "Subset List" menu.
Turn off the "Set Date Limits" function under the "Subset List" menu - select "Clear", then select
"OK". Turn off the "Display Company" function under the "Options" menu.



Select "Set Date Limits" from "Subset List" menu; then "Event - Any Check".



Six: Gordon, Irvings, Kraus, Lindstrom, Norris, and Porter.



Select "Set Date Limits" from the "Subset List" menu. Set the Start Date to read "07/01/91", and
the End Date to read "09/30/91" (the third quarter is July, August, and September). Next, select
"Event - Any Check" from the "Subset List" menu, and put an "X" next to the Yes box next to
"Project Completed". Highlight George Gordon in the people list, and look at his events. Look at
some of the others, as well. Now, select the "Show Only Selected Events" function under the
"Options " menu. Now highlight each person on the list and look below at their event(s). Each
shows only the event that caused their selection into this subset list. If you want to list their

companies, toggle the "Display Company" function under the "Options" menu. Restore
the database and clear the date, using the "Subset List" menu, and return the people list to
individuals' names.



Don't work too hard. Find him and look at his event titles.



September 27, 1991.



You probably looked at the HINT already. Don't make everything difficult, just because you have
a program that will make multiple event searches. Select any name in the people list and type
an "S". Continue scrolling down the list (one more name) to find Mr. Smith. Look in the event
box at the bottom of the screen. There is your answer. Remember, the event titles are
important. And, not every event has to have a box checked to be found easily.



Search for "Projected Cash Flow" and "Loan Submitted". Use the date range and show only
selected events to determine when the loans were actually submitted.



Two were submitted in Sept: Otis and Smith. Two in Oct.: Andrews and Carter.



You might come up with the wrong answer on this one unless you think like a computer.

Although we are asking about cash flow projections, on of the Event categories, the date range
part of the question only applies to the submission of the loans. If you set the date for the
search, you will only find two of the four people that have such events. This is because their
projected cash flow events occurred prior to September. So, do it this way: Select "Event - All
Checks" from the "Subset List" menu. Put an "X" in the Yes box next to "Projected Cash Flows",
and an "X" in the Yes box next to "Loan Submitted". Select "OK" to return to the main PMS
screen. You now have a list of four people that match both criteria. Now, let's limit the date
range for the events to September only. Select "Set Date Limits" from the "Subset List" menu.
Change the Start Date to read "09/01/91", and the End Date to read "09/30/91. Now select
"Show Only Selected Events" from the "Options" menu. The event titles in the event box at the
bottom of your main PMS screen will be restricted to those events only that occurred in
September. Highlight Alicia Andrews; she has no events. Highlight Catherine Carter. She has
an event, but it is related to the cash flow projections; not the loan submission. If you want to be
sure, double click her event and see that "Loan Submitted" is not checked. Highlight Orville Otis;
only one event shows for September. It shows the loan submission you are looking for (that's 1).
Again, if you want to be perfectly sure, double click his event, and your will see that the "Loan
Submitted" box is checked. Highlight Mr. Smith. Same singular event (that's 2). To finish the
exercise, repeat the procedure by resetting the date limits: set the Start Date to read
"10/01/91", and the End Date to read "10/31/91. You will verify the other two loan submissions.



There are two separate questions. Answer them individually.



Two projects were completed: Kraus and Lindstrom. No follow ups were sent.



If you set the date limits to September, and searched by both "Project Completed" and "Follow Up
Sent", you will get a response of "0 Records Selected". There are two separate questions here;
and even though they depend on each other, and they involve the same people, they must
remain separate. When you look at the answer, you can see why. Since no follow up letters
were sent out in September (in fact none were ever sent by Quick Start), PMS would have to tell
you there were no matches to the multiple-event search. So, let's do it the right way. Select
"Set Date Limits" from the "Subset List" menu. Set the Start Date to read "09/01/91" and the
End Date to read "09/30/91". Now, select "Event - Any Check" from the "Subset List" menu. Put
an "X" in the Yes box next to "Project Completed", and select "OK". You will find the two people
whose projects were completed. Next, we are going to remove the date limits, as the follow up
letters might have been sent in October (or some other time). Select "Set Date Limits" from the
"Subset List' menu. Select "Clear", and then "OK" when the date box appears. The "Date Set"
message no longer shows on your screen. Select "Event - Any Check" from the "Subset List"
men, and put an "X" in the Yes box next to "Follow Up Sent", and select "OK". PMS will tell you
that no follow up letters were sent. If there were, in fact, follow up letters sent, you would simply
have looked down the people list to see if Kraus or Lindstrom appeared. Don't forget to restore
to full database.



It's two questions again. Do the search, and look at the events. If you want to use some
computer power, use the "Show Only Selected Events" instead of the date limits.



April= 1 (Downes); June= 1 (Gordon); July= 1 (Adams).



The question of when the estimates were prepared is not something you want to tell PMS to
search for; if you did, you would have to change the date limits once for each month during your
search period. And, if you did it that way, you would want to find the people for whom we have
prepared estimates first, then toggle the date ranges. With a small database like the one we're
working with here, we'll use a little common sense. Select "Event - Any Check" from the "Subset
List" menu, then put an "X" in the Yes box next to "Estimate Prepared"; select "OK". You now get
a list of three people for whom estimates have been prepared. The second part of the question
is in what month. Select "Show Only Selected Events" from the "Options" menu. This will leave
only the event for each person that was the selection criteria for structuring the subset list.
Regardless of what the event title says, you will find that the box next to "Estimate Prepared" will
be checked. Make note of the month of each event, so you can schedule them. Don't forget to
restore to full database.



You have to think like a computer on this one.



"Event - Any Check" will yield all names. "Event - All Checks" will yield three.



You know the search procedures by now. But, can you explain why the answer is correct? To
understand it, you have to think a little like a computer. But, if you can do this, you will be better
prepared to ask PMS questions; with predictable and accurate results. When you specify "Event -
Any Checks", you are asking PMS to find records that have any "No" in any box; of any event.

Any event record that has the lack of a "Yes" check in any box at all will qualify for the subset list.
On the other hand, if you ask PMS to get you a list of the people who have records with all "No"'s
in them, he can find them. That's because there are records in this database that were recorded
without any checkbox being checked (3 of them). A good system check might be to require
some box be checked (perhaps an [open] category, or an [non-classified event] category). Using
this idea, you would be able to check your database periodically, to verify that each event has
been entered completely. Just to go one step further in computer logic, if we had checked every
event checkbox with a Yes, PMS would only give you 49 names on the first search.






Quick Start Questions - Category #4 - About Individual People in the Database

Prepare a report for, Ms. Alicia A. Andrews, listing her address, all phone numbers, each of her
"people category" classifications, any personal comments, and a listing of all events logged for
her name. Include the date and time of each event logged, and any notes or comments
recorded for each event in the file.

Prepare a report of all prospective clients, showing the information required in #33 above).

Prepare a report to print out all the activity in connection with lawyers between August 15,
1991and September 15, 1991. Show their address and all phone numbers, people
categories,and list their events with the times, date, event titles, and event categories. Also
show the event details.

Prepare a report that shows only the last activity for all persons in the database that are
classified as "Service Business". List the address, phone numbers, and all people categories.
When it comes to the events, list only the last one, and do include the event comments.

Prepare a report to show all the activity for lawyers in our database. List the selection criteria;
then only their names, together with the activities in the file. Include times, dates, and
event titles. Do not include event classifications or event comments.

Prepare a report showing each CPA, and the last contact with each one. Show the event title,

time and date of the contact, but no other information.

Prepare a report to show the activity for all full-billing clients between October 1 and Oct 15,

1991. List each contact on that date, with the persons' names, the time of day of the contact,
and the event titles. Do not show event categories or event comments.

Prepare a report that lists the nhames of all independent contractors in the database.

Prepare a report that will show the number of people in each "people category" and the nhumber
of events that have been classified by checking an "event category".

Print out a mailing list for everyone in the database. Use a label format that is 2 labels across.



Prepare a report for, Ms. Alicia A. Andrews, listing her address, all phone numbers,
each of her "people category" classifications, any personal comments, and a listing
of all events logged for her name. Include the date and time of each event logged,
and any notes or comments recorded for each event in the file.

Hint

Answer

Procedure



P